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Alice Wong
The Disability Visibility Project is an online 

community dedicated to creating, sharing, and 

amplifying disability media and culture.

Wong, A. (2020). Disability visibility: First-person stories 
from the twenty-first century. Vintage Books, a 

division of Penguin Random House LLC.

Wong, A. (2022). Year of the tiger: An activist’s life. 

Vintage Books, a division of Penguin Random 

House LLC.

Wong, A. (2024). Disability intimacy: Essays on love, 
care, and desire (1st ed.). Knopf Doubleday 

Publishing Group.
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Do not edit

How to change the design

What do you find frustrating 
when it comes to making 
digital content accessible?

Presenting with animations, GIFs or speaker notes? Enable our Chrome extension

https://www.slido.com/support/gsi/how-to-change-the-design
https://www.sli.do/features-google-slides?interaction-type=T3BlblRleHQ%3D
https://chrome.google.com/webstore/detail/slido/dhhclfjehmpacimcdknijodpjpmppkii
https://www.sli.do/features-google-slides?payload=eyJwb2xsVXVpZCI6IjhhMGMwMzFmLTY3N2ItNGNmYi1hYTA0LWE4NGQxOTQyOGM4ZiIsInByZXNlbnRhdGlvbklkIjoiMTNkUnZRbXJaMEd1MzNwdkpXT0FIcmFMSEZSWU5EQzBqU1gwTFBUR0EwdG8iLCJzbGlkZUlkIjoiU0xJREVTX0FQSTE2ODQyMzU1NzlfMCIsInRpbWVsaW5lIjpbeyJwb2xsUXVlc3Rpb25VdWlkIjoiM2Q2Yzc4ZTgtZGM4Yy00MDExLTk3YTMtZDU4ZGE4M2QzYmYwIiwic2hvd1Jlc3VsdHMiOnRydWV9XSwidHlwZSI6IlNsaWRvUG9sbCJ9


Objectives
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Differentiate between alt text, long descriptions, 
and decorative images

Produce alt text and long descriptions for images

Assign a heading structure to a document
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US Disability Legislation

Rehabilitation 
Act of 1973

Section 504

Americans with 
Disabilities Act

Section 508 
Rehabilitation 

Act of 1973

ADA Title II 
Updates
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1973 1990 1998 2026

Association of Research Libraries. 
(2024). ADA Title II regulations: 
Implications for libraries. 

https://www.arl.org/wp-content/uploads/2024/10/ADA-Title-II-regulations_-implications-for-libraries.pdf
https://www.arl.org/wp-content/uploads/2024/10/ADA-Title-II-regulations_-implications-for-libraries.pdf


Alt Text
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WCAG 2.1 Success Criterion 1.1.1 Non-text Content (Level A)

All non-text content that is presented to the user has a text 

alternative that serves the equivalent purpose, except for [some 

exceptions].

https://www.w3.org/WAI/WCAG21/Understanding/conformance#text-alternatives
https://www.w3.org/TR/WCAG21/#dfn-non-text-content
https://www.w3.org/TR/WCAG21/#dfn-text-alternative
https://www.w3.org/TR/WCAG21/#dfn-text-alternative


Alt text demonstration

7
ATRC CSU. (2021, September 20). Screen Reader: Image without Alt Text [Video]. YouTube.  (32 seconds)

https://www.youtube.com/watch?v=pc4RVw691cQ&t=32s
http://www.youtube.com/watch?v=pc4RVw691cQ


DoIt Center Screen Reader Video

8
DoIt Center (2017, October 3). Using a Screen Reader (Audio Described). YouTube (7 minutes)

https://www.youtube.com/watch?v=5UD4BKAJZnQ
http://www.youtube.com/watch?v=5UD4BKAJZnQ


What is alt text and why is it important?
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● Used for images, pictures, illustrations, 

infographics, and diagrams

● Assistive technology

○ People who use screen readers 
WebAIM Screen Reader User Survey

○ Refreshable braille display

● Low internet bandwidth

● Improves SEO

Andreas Nylin’s Image Alt Text Viewer

Alternative text (alt text)

https://webaim.org/projects/screenreadersurvey10/
https://chromewebstore.google.com/detail/image-alt-text-viewer/nhmihbneenlkbjjpbimhegikadfleccd


Alt text decision 
tree
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Alt Text: What to Write from 
Norman Nielsen Group

See also WebAIM’s An alt Decision 
Tree

https://www.nngroup.com/articles/write-alt-text/
https://www.w3.org/WAI/tutorials/images/decision-tree/
https://www.w3.org/WAI/tutorials/images/decision-tree/


Use alt text to convey important information

Writing for Web Accessibility by W3C

https://www.w3.org/WAI/tips/writing/


Alternative text guidelines
● All images need alt text.

● Include relevant content provided by the image, rather than simply describing how the 

image looks.

● Do not include extra or unnecessary information.

● Do not start with “image of” or “picture of”.

● Avoid images with text, but if necessary only include words in the image in the alt text.

● Be concise, 125-150 characters or under is ideal.

● Use proper capitalization and punctuation. End alt text with appropriate punctuation.

● Alt text must be in the same language as the main content.

● Do not stuff alt text with keywords to promote search engine optimization (SEO).

https://docs.google.com/document/d/1TFr2ltPvAQNuhx_jSujKby5sLwrq92IZne0pNLYytxU/edit?usp=sharing


Logos

13

Only include the words in the 

image

Do
Write alt text that does not reflect 

the words in the image

Don’t



Let’s practice

How would you write alt text 

for this image? Share your 

answer in our 

RefWorks Alt Text Activity 

Padlet.

https://bit.ly/4joYh2Z
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https://padlet.com/bfennell3/refworks-alt-text-activity-d8axarpwcinlcg05
https://padlet.com/bfennell3/refworks-alt-text-activity-d8axarpwcinlcg05
https://bit.ly/4joYh2Z


Padlet
1. Activate the QR code or 

visit the RefWorks Alt Text 

Activity Padlet or 

https://bit.ly/4joYh2Z

2. Click on the plus sign in the 

lower right corner.

3. A white “pad” will appear.

4. Write your answer in the 

pad and click on “Publish” 

to share with the group.
15

https://padlet.com/bfennell3/refworks-alt-text-activity-d8axarpwcinlcg05
https://padlet.com/bfennell3/refworks-alt-text-activity-d8axarpwcinlcg05
https://bit.ly/4joYh2Z


My alt text

RefWorks icon is listed under 

Send to in the USC Libraries 

Catalog record for a journal 

article.
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Add Alt Text to 
LibGuides Part 1
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To add default alternate text to 

an image:

1. From your LibApps 

dashboard, click on the 

Image Manager link on the 

command bar.

2. Click on the thumbnail of 

the image you want to 

edit.

https://ask.springshare.com/libapps/faq/639
https://ask.springshare.com/libapps/faq/639


Add Alt Text to 
LibGuides Part 2
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1. In the Edit Image 

Properties modal, enter 

your descriptive text into 

the Alternative Text field. 

This will appear in the 

image's alt attribute (e.g. 

<img alt="Your alternate 

text displays here">).

2. Click the Save button.

https://ask.springshare.com/libapps/faq/639
https://ask.springshare.com/libapps/faq/639


Add Alt Text to Word 
Document
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Microsoft Support: Add alternative text to a shape, 

picture, chart, SmartArt graphic, or other object

● Do one of the following:

○ Right-click the object and select Edit Alt 
Text.

○ Select the object and then select the format 
menu for the object, for example, Picture 
Format. Select Alt Text.

● In the Alt Text pane, type 1-2 sentences in the text 

box to describe the object and its context to 

someone who cannot see it.

https://support.microsoft.com/en-us/office/add-alternative-text-to-a-shape-picture-chart-smartart-graphic-or-other-object-44989b2a-903c-4d9a-b742-6a75b451c669
https://support.microsoft.com/en-us/office/add-alternative-text-to-a-shape-picture-chart-smartart-graphic-or-other-object-44989b2a-903c-4d9a-b742-6a75b451c669
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Add Alt Text to 
Google Docs
Google Support: Make your document, 

presentation, sheets & videos more 

accessible

In Google docs either right click on the 

image to access the image options menu, 

Add alt text in the description field.

Alternatively, select the image, then 

navigate to the Format menu and select 

Image and then Options to add an alt 

text description.

https://support.google.com/docs/answer/116338?sjid=14682660137272207922-NC
https://support.google.com/docs/answer/116338?sjid=14682660137272207922-NC
https://support.google.com/docs/answer/116338?sjid=14682660137272207922-NC


Decorative Images
● Purely decorative image

● Does not contribute meaning to the 

information

● Null alt text, HTML code alt=" "

● Actively enter an empty “space” or mark 

as decorative

● Some rich content editors allow you to 

check a decorative image box

WAVE Web Accessibility Evaluation Tools
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https://www.w3.org/TR/WCAG20-TECHS/H67.html
https://wave.webaim.org/


Decorative Images in Rich Content Editors

22
Microsoft SwayMicrosoft Word



Cover Art in LibGuides
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Using the null alt text attribute, assistive 

technology will ignore the image.

Syndetics provides generic alt text 

called Cover Art which isn’t helpful.



Long Description

02
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WCAG 2.1 Success Criterion 1.1.1 Non-text Content (Level A)

All non-text content that is presented to the user has a text 

alternative that serves the equivalent purpose, except for [some 

exceptions].

https://www.w3.org/TR/2016/NOTE-WCAG20-TECHS-20161007/G73
https://www.w3.org/TR/WCAG21/#dfn-non-text-content
https://www.w3.org/TR/WCAG21/#dfn-text-alternative
https://www.w3.org/TR/WCAG21/#dfn-text-alternative
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Provide Context in 
Document

● Write brief alt text and indicate 

where reader can find detailed 

informative explanation.

● Include narrative description of 

image in the text of the document

● Universal Design for Learning

https://libguides.calstatela.edu/WriteAndCite/MLA

https://libguides.calstatela.edu/WriteAndCite/MLA
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Provide 
Supplementary 
Document
● Write brief alt text and indicate 

where reader can find detailed 

informative explanation.

● Include accessible text version

Cal State LA Library Should I Cite?

https://libguides.calstatela.edu/c.php?g=1315165&p=9669928#s-lg-box-30596713


Accessible Online Documents
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California Dyslexia Guidelines. (2017). California 
Department of Education. 

https://www.cde.ca.gov/sp/se/ac/documents/cadyslexiaguidelines.pdf


Long Description in Sage
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Salmons, J. (2022). Research skills: 

Defining terms within theory. In SAGE 

Skills: Student Success.  

https://doi.org/10.4135/9781071881835

https://doi.org/10.4135/9781071881835


Headings and Structure

03

29

WCAG 2.1 Success Criterion 2.4.10 Section Headings (Level AAA)

Section headings are used to organize the content.

https://www.w3.org/WAI/WCAG21/Understanding/section-headings.html


Headings demonstration

30
ATRC CSU. (2021, September 20). Screen Reader: Document Without Headings [Video]. YouTube.  (1 minute)

https://www.youtube.com/watch?v=xaK6rlzhqHc
http://www.youtube.com/watch?v=xaK6rlzhqHc


Headings Best 
Practices
● Use levels in hierarchical and 

chronological order <h1> through 

<h6>

● Don’t skip levels.

● Use <h1> only once per webpage.

● In long documents more than one 

<h1> is acceptable.

● Be succinct and descriptive.

● Do not use visual formatting like 

bold, underlining, or changing font 

size instead of a heading structure.

Paul J. Adam’s JavaScript Bookmarklets for 

Accessibility Testing

https://pauljadam.com/bookmarklets.html
https://pauljadam.com/bookmarklets.html


Headings knowledge check

Headings can be used in any order. A. Use a bold font to create headings in 

a document.

B. Headings organize document 

content for sighted, blind, and 

low-vision readers.

C. Headings provide HTML code so 

screen reader users can efficiently 

navigate a digital document.

Which statement is true? True or False?

32

Answer: False, use headings in a 

hierarchical and chronological order <h1> 

through <h6>.



Guided 
Activity

1. Visit https://bit.ly/ActivityCCLI to access a read-only version of this 

document. Make a copy to your Google Drive.

2. Read the text. Determine where to assign Level 1 and Level 2 

headings. On the paper, mark where you will assign headings.

3. We will work together through guided practice to assign headings.

33

https://bit.ly/ActivityCCLI


Assign Headings in 
LibGuides
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● Open the Rich Text Editor

● Highlight text to be formatted with a 

heading level

● Navigate to “Paragraph Format”

● Select the heading level

● Don’t forget to “Save and Close”



Assign Headings in 
Word

35

● Select the text you want to use as a 

heading.

● On the Home tab, move the pointer 

over different headings in the Styles 

gallery. Notice as you pause over 

each style, your text will change so 

you can see how it will look in your 

document. Select the heading style 

you want to use.

● Add a heading in a Word document 

video and instruction for Windows 

and Mac.

https://support.microsoft.com/en-us/office/add-a-heading-in-a-word-document-3eb8b917-56dc-4a17-891a-a026b2c790f2


Headings in 
Google Docs

36

Google Support Add a title, 

heading, or table of contents in 

a document

1. Click on the Format menu

2. Select Paragraph styles

3. Select the desired 

heading level to apply to 

text

4. Update will change the  

style of the heading

https://support.google.com/docs/answer/116338?sjid=14682660137272207922-NC
https://support.google.com/docs/answer/116338?sjid=14682660137272207922-NC
https://support.google.com/docs/answer/116338?sjid=14682660137272207922-NC


Accessible Titles
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The “title” heading level In Word in 

not accessible to assistive 

technology.

To add a title to a Microsoft Word 

or PowerPoint file, navigate to File 

> Properties > Summary to enter 

the document title.

In Google Docs, use the field 

located in the upper left corner of 

the document window. By default, 

new documents are assigned the 

title “Untitled document”.

See Titles at the University of 

Washington for more information.

https://www.washington.edu/accesstech/checklist/titles/


Structure in Slide Decks
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● Create Accessible Google Slides 

Harvard University Digital 

Accessibility

● Grackle Slides accessibility checker

● Get accessible templates for Office

● Make slides easier to read by using 

the Reading Order pane

● WebAim PowerPoint Accessibility

● Create Accessible Presentations

Microsoft PowerPoint Google Slides

https://accessibility.huit.harvard.edu/google-slides
https://workspace.google.com/marketplace/app/grackle_slides/273764076887
https://support.microsoft.com/en-us/office/get-accessible-templates-for-office-ca086caa-2bd2-4ac8-8c12-4cd495bd4d76
https://support.microsoft.com/en-us/office/make-slides-easier-to-read-by-using-the-reading-order-pane-863b5c1c-4f19-45ec-96e6-93a6457f5e1c
https://support.microsoft.com/en-us/office/make-slides-easier-to-read-by-using-the-reading-order-pane-863b5c1c-4f19-45ec-96e6-93a6457f5e1c
https://webaim.org/techniques/powerpoint/#links
https://www.section508.gov/create/presentations/


Listen to Stevie Wonder

39
Slate. (2018, June 18). Stevie Wonder Braille Award [Video]. YouTube.  

https://www.youtube.com/watch?v=3QjrF-k7SzY
http://www.youtube.com/watch?v=3QjrF-k7SzY


Do not edit

How to change the design

What is one thing you 
learned in this workshop 
that surprised you?

Presenting with animations, GIFs or speaker notes? Enable our Chrome extension

https://www.slido.com/support/gsi/how-to-change-the-design
https://www.sli.do/features-google-slides?interaction-type=T3BlblRleHQ%3D
https://chrome.google.com/webstore/detail/slido/dhhclfjehmpacimcdknijodpjpmppkii
https://www.sli.do/features-google-slides?payload=eyJwb2xsVXVpZCI6ImQ5YjMxYWE3LWI4NWQtNDcwYS04ZDdiLTRmNTVkZDgyZWM0ZiIsInByZXNlbnRhdGlvbklkIjoiMTNkUnZRbXJaMEd1MzNwdkpXT0FIcmFMSEZSWU5EQzBqU1gwTFBUR0EwdG8iLCJzbGlkZUlkIjoiU0xJREVTX0FQSTQ3Njc3MDczNV8wIiwidGltZWxpbmUiOlt7InBvbGxRdWVzdGlvblV1aWQiOiJmNjMxZDcwMC04NjU3LTQwZGYtYWUyMi04ZGQ3MDk2OTliNGIiLCJzaG93UmVzdWx0cyI6dHJ1ZX1dLCJ0eXBlIjoiU2xpZG9Qb2xsIn0%3D


CREDITS: This presentation template was created by 
Slidesgo, and includes icons by Flaticon, and 
infographics & images by Freepik 

Thanks!
Please take a few minutes to 

complete the exit survey

Do you have any questions?

bfennell@usc.edu
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https://bit.ly/3A1uf1Q
http://bit.ly/2TyoMsr
http://bit.ly/2TtBDfr
https://docs.google.com/forms/d/e/1FAIpQLSew12wx-IuwLqIdS6RjYNvJh37Ny2sKZijipQyV4YRRpV9s-A/viewform?usp=header


Articles
Liu, Y. Q., Bielefield, A., & Beckwith, J. (2024). ADA digital accessibility on academic library 

websites. College & Research Libraries, 85(2), Article 2. https://doi.org/10.5860/crl.85.2.166

Lomax, B. (2024, November 1). 10 Tips toward Accessibility. American Libraries Magazine. 

https://americanlibrariesmagazine.org/2024/11/01/10-tips-toward-accessibility/

Miller, M., & Parogni, I. (2022, February 18). The hidden image descriptions making the internet 

accessible. The New York Times. 

Wentz, B., Gorham, U., & Jaeger, P. T. (2023). Academic libraries and their legal obligation for 

content accessibility. First Monday. https://doi.org/10.5210/fm.v28i1.12892

https://doi.org/10.5860/crl.85.2.166
https://www.nytimes.com/interactive/2022/02/18/arts/alt-text-images-descriptions.html
https://www.nytimes.com/interactive/2022/02/18/arts/alt-text-images-descriptions.html
https://doi.org/10.5210/fm.v28i1.12892


Resources
Training

● University of Michigan Self-Paced BTAA Cultivating Belonging: Library Accessibility 

Essentials

● College/university compliance trainings and centers for teaching excellence

LibGuide Accessibility

● University of Tennessee Knoxville Library

● Harvard LibGuides Best Practices

● NYU LibGuide Accessibility

Accessibility Communities

● WAVE Web Accessibility Evaluation Tools
● Educause IT Accessibility Community Group

● Accessibility Summer Camp June 13, 2025 $15, ASC YouTube Channel

● Axe-Con from Deque Systems Deque Systems YouTube Channel

https://btaalib.catalog.instructure.com/courses/self-paced-btaa-cultivating-belonging
https://btaalib.catalog.instructure.com/courses/self-paced-btaa-cultivating-belonging
https://libguides.utk.edu/libguide-accessibility/home
https://guides.library.harvard.edu/c.php?g=1007543&p=7299431
https://guides.nyu.edu/nyu-libguide-accessibility/a11y-overview
https://wave.webaim.org/
https://www.educause.edu/community/it-accessibility-community-group
https://www.accessibilityict.org/
https://www.youtube.com/@AccessibilityICT
https://www.deque.com/axe-con/
https://www.youtube.com/@DequeSystemsInc

